AccessingDB2 from Excel
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1. Introduction
In this tutorial we will show you how to build an Excel application to access DB2 via the SOA
Gateway.

2. Prerequisites

It is assumed that you are running the 3 components, DB2, Excel and the SOA Gateway on Windows.

It is assumed you already have a SOA Gateway server and Control Centre installed. See here for
more info about installing the SOA Gateway.

3. Setup
It is assumed that you already that MS Excel installed as part of the MS Office suite of products.

Youwi | | al so need a DB2 database. | BM provides a
Express-C ” . thBlanlefor the DB2 Express-C homepage. Download and install a version of DB2
Express.

Populate DB2 Database
Now that you’ve got DB2 installed, we need to po
the Risaris Bank Demo, which is available here. Save this fileto“ &Temp\Ri sar i sBank _db2. so¢

T Open the DB2 Control Centre under *“I BM DB2",
T Right click *“All databases” and select “Creal
T Name your new database “RI SBARNHt'soclic Wl I ot her
“Finish”.
T Open a DB2 command shell by typing “db2cmd” i
9 From the db2 command shell, change directory to where you downloaded the
Ri sari sBank \deadpsqgl . E.g “cd
1T Popul ate the RISBANK dat ab-aRies aryi ssBianmk _ndyb 2 .hseq
you may see errors about “SYSTEM. CUSTOMERI NF

occur because the RisarisBank_db2.sql attempts to drop any existing tables before creating
new ones. To prove this, you can run the same command again, and the errors will
disappear.

9 You can now return to the DB2 Control Centre and view the newly created tables in the
RISBANK database.

Set up ODBC Access
The final thing to do with your DB2 Database is to set up an ODBC DSN which will be used by the
SOA Gateway to access this database.

Click Start, Control Panel, Administrative Tools, Data Sources (ODBC)

From the resulting screen, choose the “System DS
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http://www.risaris.com/documentation/v411/installation/index.htm
http://www-306.ibm.com/software/data/db2/express/
http://risaris.com/samples/RisarisBank_db2.sql

Click Add
From the 1| i st of data source dr i vienriss,h”"s.el ect “ | E
Enter “RisarisBank_ _db2" as the Data source Name.

Ensure that the Database Alias is RISBANK, and cC

ODBC IBM DEZ Driver - Add b3 I

Select the DBEZ databaze aliaz you want to register for QDEBC,
ar zelect Add ko create a new aliaz. You mayp change the
data zource name and description, or accept the default,

D ata source name IHisarisBank_dI:uE

Databaze alias I RISBAME. j &dd
D escription I
OF. Cancel |
4. Discovery

At this stage you’'ve got I nfoPath installed, and
section we’ Itdcreselwoebwervigesftom éach of the DB2 tables. These web services

can be used by the InfoPath language (and many others) to give you direct real-time access to your

DB2 Data.

4.1.Web Service Creation using SOA Gateway
Start your SOA Gateway Control Centre. See here for an introduction to the Control Centre.

In your servers view, right click the entry which represents your local SOA Gateway Server. Select
“Create New Web Services”.
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http://www.risaris.com/documentation/v411/gettingstarted/intro.htm

e —_
.. SDA Gateway Servers (. Eq fit 50A Gateway Sery

«> ¥ ¥ | WebServices I[)ata'lu

Name | M... | ASY | Tracing | il L| Driver
ALY Server Y  OFF/7T

= Lm:al Server
2/05 Server t:gh Refresh Configuration

Suspend Server

2] set Credentials For Server

VAJ Save current Configuration ko server File
& | Import Configuration into Control Center

& Export Configuration from Control Center

5 Export WebService Definition(s) to server

¥ Remove Server definition -
ki
&5 Add new S04 Gakeway conneckion EI“
From the next dialog, choose “DB2 Driver?”. | f

how to create one here.

1
I HSDA Gateway - WebService creation E

This wizard will guide you through the process
of generating new WebServices.

Select the source of data M
Discovery timeout (secunlzu

Mext = | Done |

Click Next.

The next screen gives you the ability to add information about your DSN
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http://www.risaris.com/documentation/v411/admin/ccserver.htm#mod_drivers

.5EIA Gateway WebService Creation {db2)

Step 1 - select input

—Specify ODBC descriptors & option{s)

ODBC Dsn IRisarisBank_th

Userld / Passwurdl

Pattern I

Max.entries to list I

—Options for generated WebService name

Advanced Options |_

Discover Cancel

Enter the above information and click Discover.
The wizard will display all the tables it finds at this (RisarisBank) DSN.
Click “Select AlIl ", and click “I mport?”

The wizard will create web services from each one of these tables.

i .| SDA Gateway Servers =3 = 0| :: spoa Gateway Server Configuration - Local Server &1

+5 [P 7| WebServices | ataviews / X5Ds / %5Ls |

Name | M... | ASY | Mod | Driver | WebSservice | Datasource Id DataYiew
ALX Server ¥ DBZ Driver ACCOUNTSMOYEMENTS_SY... | odbcDsn=RisarisBank_dbZ2, schemaNam... = ACCOUNTSMOYEMENTS_SYSTEM
DMZ ¥
dublin dev ¥ M DEZ Driver AUDIT_SYSTEM odbcD: isarisBank_dbz2, sch ... | AUDIT_SYSTEM
ik server ¥ m DBZ Driver  BRANCH_SYSTEM odbcDsn=RisarisBank_db2, schemaNam... = BRANCH_SYSTEM
jk server linux ¥
o server ¥ m DBZ Driver CURRENTACCOUNT_SYSTEM | odbcDsn=RisarisBank_dbz, schemaMam... = CURRENTACCOUNT _SYSTEM
| gLocal Server ¥ M DEZ Driver CUSTOMERACCOUNTXREF_S... | odbcD: isarisBank_dbz2, sch ... CUSTOMERACCOUNTXREF_SYSTEM
Inbre server Y
PCRIWS ¥ m DB2 Driver CUSTOMERINFORMATION_S...  odbcDsn=RisarisBank_db2, schemaMam... | CUSTOMERIMFORMATION_SYSTEM
risaris.com server T m DBZ Driver DEPOSITACCOUNT _SYSTEM odbcDsn=RisarisBank_db2, schemaNam... DEPDSITACCOUNT _SYSTEM
vse ki
M DEZ Driver TELLERTABLE_SYSTEM odbcD: isarisBank_dbz, sch ... | TELLERTABLE_SYSTEM
z/05 Server ¥
z/vse Y
1 H -
You’'ve just created 8 Web Services from your 8

4.2.Accessing the WSDL
Web Service Description Language (WSDL) is a standard, XML-based language that is used to
describe a Web Service.

For each of the 8 web services you've created
you with a WSDL to describe the Web Service. The WSDL itself is usually interpreted by a web
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service client, such as InfoPath, but it is useful to know where to find the WSDL for each of your
Web Services.

As WSDL is XML-based, it will open in your browser of choice. To see the WSDL for one of your
Risaris Bank web services, do the following in your SOA Gateway Control Centre:

T Click on the web service you are interested
9 The properties for this web service should appear in your Properties View. If you do not

see the Properties view, select Window -> Show View -> Other -> General -> Properties

and click OK.
9 Inthe properties view, there is a link to your WSDL. Click it to open the WSDL in a

browser.

... SDA Gateway Server Configuration - Local Server 3

WebServices | Data¥iews / XSDs / XSLs |
Mod | Driver | WehService | DataSource Id
DBZ Driver ACCOUNTSMOYEMENTS_SY...  odbcDsn=RisarisBank_db2, schen

DBZ Driver AUDIT_SYSTEM odbcDsn=RisarisBank_db2, schen
TP ———
DBZ Driver CURRENTACCOUNT_SYSTEM odbcDsn=RisarisBank_db2, schen
DBZ Driver CUSTOMERACCOUNTXREF_S... odbcDsn=RisarisBank_db2, schen
DEBZ Driver CUSTOMERINFORMATION_S...  odbcDsn=RisarisBank_db2, schen

DBZ Driver DEPOSITACCOUNT_SYSTEM odbcDsn=RisarisBank_db2, schen

EEERE EE

DBZ Driver TELLERTABLE_SYSTEM odbcDsn=RisarisBank_db2, schen

-
:i. SDA Gateway Actiop”. g &3

I Server name e

i Local Server <overy completed, 8 WebService(s) generated

=
E Properties 3

webService properties

\ /
Resource - WebService I3
Name IBRnNEH_S\"STEM
Data¥iew IBRA.NIZH_S\"STEM |

Driver IDBZ Driver "l SBCS-Codepage I
Read-only [] MBES—Endepagel

WSDL URL is . http://localhost:56000/BRANCH SYSTEMZWSDL

+ Wehbservice Identification and options

odbcDsn IRisarisBank_de

schemaMName |5"|"5TEM

tableName IBRJ\NEH
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http://www.risaris.com/documentation/v231/admin/cctop.htm

You can view the WSDL for the other web services by clicking the link from their properties
view.

This WSDL is the starting point for using Web Services, and can be used time and again by
different web service clients.

5. AccessingaWeb Service with Excel
We will use the Excel application to access our new Risaris Bank Web Services.

Open MicrosoftExcelClick on the Data tab. Click Get External Data and click the From Web

menu item.
—~SoeneTE, T B = = - = = :
(1 ,n\ = E | @ )7 e 7Boolid - Microsoft Excel
[ ol
—/ Home Insert Page Layout Formulas Data Review View Developer
) - : L -
Ex 3 E o P E o & = . " = » - 3=
'l B g \_‘-:_LEJ Connections %l E\ ,{ «} Clear _l _g %oj Data Validation < Group =
: I" Properties . {» Reapply : [Fi Consolidate ¥ Ungroup ¥ "=

Geiédemav Refresh Zl sort Filter ., Textto Remove ., : e
| ¥ f) Advanced || Columns Duplicates =2 What-If Analysis ~ :-_::]jSubtotal

Data~ : All~ == Edit Links
| Connections Sort & Filter Data Tools Cutline ]
e e &
EPRE" NEERET =5 I ‘
From From From From Other Existing E ! F 1 G H ! J K L

Access Web  Text Sources~ | Connections
Get External Data

Witk NG L kW

In the Address field type the query you wish to execute e.g.
http://localhost:56000/CUSTOMERINFORMATION SYSTEM?LIST& CUSTOMERNUMBER=*

Depending on your SOA Gateway configuration you may have to change localhost and/or the
port number of 56000.

Click on Go.

If valid the query will return the results in the data pane as shown below.
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http://localhost:56000/CUSTOMERINFORMATION_SYSTEM?LIST&CUSTOMERNUMBER=*

New Web Query @Iﬁ

Address: | http:/localhost: 56000 /CUSTOMERINFORMATION_SYSTEMZLIST&CUSTOMERNUMBER = E @ @ | @ @ B optons...

Clide [#] next to the tables you want to select, then dick Import.
»

i »

<?xml version="1.0" encoding="UTF-8" standalone="no" ?=
- =CUSTOMERINFORMATION_SYSTEMRoot:

- <CUSTOMERINFORMATION_SYSTEMGroup >
<CUSTOMERNUMBER =1 </CUSTOMERNUMBER =
<FIRSTNAME =Casper</FIRSTNAME =
=<SURNAME =Ankergren</SURNAME =
<ADDRESSLINE1=34 Green Street</ADDRESSLINEL >
<ADDRESSLINE2 =Crosses Street</ADDRESSLINEZ >
<CITY =Mansfield </CITY =
<POSTCODE>MAS 9A1</POSTCODE>
<DATEOFBIRTH=30/05/1978</DATEOFBIRTH =

</CUSTOMERINFORMATION_SYSTEMGroup>

- <CUSTOMERINFORMATION_SYSTEMGroup =
=CUSTOMERNUMBER »2 «/CUSTOMERNUMBER =
<FIRSTNAME =Peter</FIRSTNAME =
<SURNAME =Richardson </SURNAME =

SAMMODEC T TRICA ~ WAl ncd Cata Awrnneon ~ARMBDES T TRICA ~

[ Import ][ Cancel l

| ttp: /lacalhost: 56000 CUSTOMER INFORMATION_SYSTEMPLISTCUSTOMERNUMBER =% | | |

Now click on Import.

When the following dialog box is displayed click on OK.

Microsoft Office Excel @lﬂ_hj

The spedified XML source does not refer to a schema. Excel will create a
schema based on the XML source data.

[] In the future, do not show this message.

Help

You are then asked where you wish Excel to place the data. Here we chose the default of SAS1.
Hit OK.

[ Import Data Ii|-3_hj1

Where do you want to put the data?
@ ¥ML table in existing worksheet:

Sheetllsasl
() Existing worksheet:
=§F$4 F

) Mew worksheet

Properties. .. ] [ QK ] [ Cancel

Excel presents the data in a nicely formatted table as shown.
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Export Refresh .,
T Resize Table E Convert to Range - - 3{. Unlink

| Banded Rows

[ Banded Columns

= w L] - A .

m-l [ I ] (& @ T Bookl - Microsoft Excel Table Tools i ool = B

Iy .g. 1 Nl — o -
~ Home Insert Page Layout Formulas Data Review View Developer Design @ - = X
Table Name: @ Summarize with PivotTable g ﬁ QPmpemes | Header Row || First Column
Tablel E’E Remove Duplicates & Open in Browser || [] Total Row [ Last Column

Properties Tools External Table Data Table Style Options Table Styles
Al - Q f | CUSTOMERNUMBER ¥
A B c D E F G H E
customernUMBER B3 FirsTnamE B3 surnave B3laporessunes  Blaporessune2 Blcry  B3postcone B|oateoreirH B3
2 1 Casper Ankergren 34 Green Street Crosses Street Mansfield MAS 9A) 30/05/1978 1
3 2 Peter Richardson West Gate Avenue Frankfield Manchester MAS 444 18/07/1948 3
4 3 Donald Smith 32 Parsons Green Lane Fulham London SWA 3JA 05/09/1938
5 4 Lillian Margues 1 Father Delahunty Street Bordesley Birminham BO44LwW 14/01/1979
6 5 Arthur Holman 12 Padbury Close Griffin Close Newcastle upon Tyne NWS 2KK 16/05/1975
7 6 Bartholomew McCarthy 22 Hillview Griffin Close York SW9 1GH 24/03/1974
2 7 Neville Lee 72 Thoresby Crescent Sinfin Leeds LS9 2DS 21/02/1980
9 8 Brian Colman 14 Gilliver Gardens ‘West Field Birmingham BAS9 3KK 20/04/1983
9 lan Burton 144 Allestree Lane Lime Kiln Lane York YRO 2NT 06/09/1971
10 Grenville Dekker 22 Uttoxter New Road Chaddesden Leeds LS4 9WE 21/10/1974
11 lane Freeman 3 Portland Street Lichfield Gloucester GlL4 8KD 26/10/1980
12 Dale Rolling The Hunters Rest Branston Preston PR4 4HG 06/12/1989
13 Arnold Corrigan 14 Anderson Street Allestree Derby DE6 8FT 10/06/1970
14 Alfred Summerscale 3701 S. George Mason Melbourne Bath BAG 3UU 07/08/1982
15 Peter Spiegel 11663 Charter Oak Co Foremark Manchester M98 4GT 29/12{1971
Sheetl ,Sheet? . Sheetd . ¥] [ m |
Ready | P3] | e E— +
—

6. Conclusion

This tutorial shows how to access DB2 from Excel using the SOA Gateway. As you can see, you have

built a powerful application that uses Web Services to retrieve information in real-time.
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